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Pandora FMS General Quickguide

INTRODUCTION
The purpose of this guide is to quickly introduce Pandora FMS to someone unfamiliar with Pandora FMS,
but who has a medium/high knowledge of systems and networks. We don’t dive deeply into all the features of Pandora FMS, but comment on the most important of them so that a user that reads the complete
Quick Guide could perform basic administration and operation tasks quickly. Consider that Pandora FMS
official training lasts 40 hours, and the official documentation has more than 1200 pages, so this is just
a small bridge to the larger documentation package for Pandora FMS.

1. Installation
We recommend that you use the Pandora FMS CD Appliance because it’s the quickest and easiest
method for intermediate users. There are several alternative ways to install Pandora FMS, but the CD
Appliance will save you many hours. For further information, please read the Pandora FMS Installation
chapter.
The installation CD is based on Linux CentOS 6.5, and contains all the elements required to make
Pandora FMS work in a pre-installed environment. You should have a machine with a minimum hardware
requirements to make Pandora FMS run properly including a minimum of 2GB of RAM and 20GB of diskspace. The Appliance CD installs well in a virtual environment, such as a VMware server.

The more systems you want to monitor the more resources (CPU, memory, Disk
speed) you’ll have to assign to the Pandora FMS server.

1.1 Installing the Appliance CD
Download the CD image from the Download section of our website and record the ISO image to a DVD,
or run the system from that file if you are using a virtualized system (XenServer, VMware, VirtualBox,
etc). There are CD images for both 32- and 64-bit installations.
The following screen will be displayed at the beginning of the boot process. If you don’t press any key
the process will automatically load the Live CD, instead of that, press any key and select the “Installation” option.
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The graphic installer will lead you step by step through the whole installing process. This installer is a
standard installation process used by CentOS, and is available in different languages. It’s a very easy
process and you’ll just have to pay special attention when introducing the superuser password (root),
and when you’ll be asked about the partitioning:

We choose “root” user password (superuser)

Pandora FMS

pag. 3

Pandora FMS General Quickguide

We choose the partitioning. Unless you know what it does, use the “Use all space” option.

1.2 First steps
Once installed, the system should boot and after a few seconds show a desktop similar to the following:

The first step should be to know the IP that the system has assigned to us to allow us to connect to the
server from outside. For that, we will open a terminal in the Applications menu Applications -> System
Tools -> Terminal. In this terminal we will write the command:

ifconfig
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In this particular case, the system’s IP address is 192.168.70.121
If the system has booted and and taken an IP from our network via DHCP it will be shown in the list. If we
want to set a static IP for this system, we can do so through the CentOS Network Configuration Interface.
Click on the right button over the network icon and “Edit connections”. The purpose of this guide is not
to detail the configuration of the base system but allow the minimum work configuration.
Once you know the IP address of Pandora FMS system, you can access it from outside the virtual machine, which is always more comfortable. You can do it via SSH or HTTP. Remember that you set the root
password (superuser) during the install configuration.
Open a browser and insert the IP address that you got from your server:

http://x.x.x.x/pandora_console

In our example it would be http://192.168.70.121/pandora_console, but you must get the IP of your
system correctly to continue. If everything is correct you will see the welcome screen of Pandora FMS
console, where you will have to enter your credentials. Once you have arrived at this point, you have a
complete installation of Pandora FMS ready to use.
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Use the credentials by default: user admin and password pandora

1.3 Enterprise licence activation

!

This section is for Enterprise users only. You can safely skip it if you are using the Open
Source version

Once we access our Pandora FMS through the browser, you will be asked to enter a valid licence:
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Click on Request new licence and proceed to the next step. In this step you need to fill the contact
information and the Auth key that our sales department has forwarded to you.

Proceed to the next step clicking on Online validation, and finally in the next step clicking on Validate.

1.4 Enterprise server start
!

This section is for Enterprise users only. You can safely skip it if you are using the Open
Source version

After activating your license, the Enterprise server must be started. In your Pandora box, open a terminal
through Applications -> System Tools -> Terminal, and type:

sudo /etc/init.d/pandora_server start
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To verify that is working, access your Pandora FMS through the browser and go to Manage Servers.
You should view something like the following:

2. Detecting problems with your network
To start exploring with Pandora FMS, your best option is to detect and monitor the devices that are on
your local network. No matter if they are PCs with Windows, Macintosh, Linux servers or routers and
switches because we are doing a very basic monitoring (check if they answer to a ping). Once they are
detected we can improve the monitoring.

2.1 Create a Recon Task
Let’s follow the next steps.
In the side menu go to “Manage Servers” -> “Manage Recon
Task” as shown in the image below, and click on Create Recon
Task button.
Create the task as in the screenshot below.
You will have to modify only the network range to explore. In this
screenshot is 192.168.70.0/24 which means that all the hosts of
the 192.168.70.xx network will be explored. Use here the appropriate IP address range to define your network.
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“Basic monitoring” network template which covers uniquely the latency and network availability
checks has been selected. Group “Network” will be used to consolidate the detected devices has been
selected. From now on we will call “agents” (in a generic way) the devices managed or monitored by
Pandora FMS.
Once created it will show us the entry, and we must click on the lens icon to see the task details, as
shown in the screenshot below:

By clicking on the lens icon, we will be shown the current status of the task, which indicates the task
execution. In this screenshot you can see how the progress bar advances, indicating that Pandora FMS
is searching systems on the network to add to the monitoring interface.
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2.2 Review the detected systems
At this point, we recommended that you wait until the network has been fully detected. Click on Refresh
tab. When you are finished, go to Agent Detail view to see all the systems detected. Menu “Monitoring” -> “Agent detail”, as in the image:

Here we can see several systems that have been properly detected by Pandora FMS. Sometimes the
name of the system would have been resolved (if possible by DNS), and in other cases the OS would
have been detected. When clicking on the name of the system (in this case the first of the screenshot),
we are forwarded to the Agent Detail view which displays all the information collected about that system.
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3. Add Remote Check to an already monitored system
Now that we have our systems detected, we are going to add some monitoring modules. Let’s add the
following monitoring:

•
•
•
•

Network traffic on an interface.
Packet loss in the network.
Check if a service is answering on the network through a TCP port.
Check a website..

3.1 Network traffic on the interface
To monitor network traffic, it is essential that SNMP is configured in the remote device. This usually
needs to be activated and a minimum configuration be implemented that allows us to consult data. The
SNMP device allows to configure the IP that can make queries, and with which community, and using
what password.
First of all we have to locate the agent from where we want to get the network traffic, in our case it’s
192.168.70.1. Following the same process (Monitoring -> Agent Detail View) we’ll go to the Main
View of the agent we want to configure and we will click on the last tab on the right, which will take us
to the edit view of that agent.

Now we go to the Agent Edit main view. We’ll have to show the configuration wizard submenu for this
agent, we’ll choose the SNMP Interface wizard, as you can see in the next screen:
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At this point, we must provide the “SNMP community” that we have configured on the target machine,
and ensure that the device supports SNMP queries enabled in the IP shown on the screen. We can
change the IP address and the SNMP community, which is set to public by default. (In our case it is
different, ‘artica06’). Once filled, we click on the “SNMP Walk” button. If everything goes right, it will
show the interfaces and the data that we can get from them.

With CONTROL-Click (or CMD-Click in Mac) we can select more than one element in both boxes such us
in the following screenshot. We recommend monitoring the outgoing traffic (ifOutOctets), the incoming
traffic (ifInOctets) and the status of the interface (ifOperStatus) on each interface. In this particular
case, eth1, eth2 and eth3. We click on “Create modules” button and a screen should inform us about
the modules that have been created.
We must consider that the network traffic modules are incremental type, ie its value is the difference
between the sample of information that we’ve just taken previously and the current information, ie, it
shows us a “rate” (in this case bytes/sec) so it takes time (between 5 and 10 minutes) before showing
anything.
He have to click on “View” tab to return to the Agent View, and wait 5 minutes to have traffic data,
refreshing or clicking on the “View” tab. After a while, we will have a screen similar to that below, whe-
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re we have data regarding the traffic modules (incoming
and outgoing separated), and a new section in the agent
that shows information about the interfaces with direct access to an aggregate graph with the outgoing and incoming traffic overlay (click on the title “Interface information
(SNMP)”.

If we don’t want to wait we can use the force remote check icon (it wont work with local modules, or
with modules collected in local by a software agent). Depending on the load of our server it could take
between 2 and 15 seconds to execute the network test.

The information of the traffic modules will be displayed like this, with graphs per each metric. Clicking
on the graph icon will show a window with the graph of this monitor, and when we click on the data icon
it will show a table with data.
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3.2 Packet loss on the network
We want to add a remote plugin pre-configured in Pandora FMS. Remote plugins are checks defined by
the user that use a script or software deployed in the Pandora FMS server, so that it could be used for
monitoring, increasing the variety of tools available to us in Pandora FMS.
Let’s use a serial plugin. For that we must go to the Agent Edit View, and then to the Module Configuration tab.

We will choose a module type plugin and we’ll click on “Create” button, which will lead us to the interface of configuration for “plugin remote” type modules.
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We’ll choose “Packet loss” using the drop down, and finally we’ll introduce the IP address of the target
for which we want to implement the checks. We leave the rest of fields as they are.

We’ll click on the “Create” button and return to the Operation View, as in the case described above.
We’ll refresh a couple of times until the new module appears in the list:

This is a very interesting plugin that, when used with the basic connectivity (ping) and latency time,
helps us to determine the quality of our network, because the result reveals to us the percentage of
packet loss taking samples every 5 minutes.

3.3 Monitor a TCP network service
In this particular case we are going to add a monitor to verify that a SMTP services (mail) is active in a
machine. Although it can be a very complex check (simulating that we send an email, or user and password credentials, etc) we’ll simplify it by checking only that the port is open and answers.
For that, we’ll repeat the same initial steps of the previous example, but this time we will pick “Network
Module”.
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After that we’ll use the drop down controls to find our check (Check SMTP Server) and we’ll click to create the module.

Finally, we’ll repeat the steps (go to the Operation View, and refresh until the monitor appears) so that
the final result will be something similar to the following:
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3.4 Check a website
In Pandora FMS Enterprise version is possible to do synthetic WEB checks, ie sending data, keep the
session alive, and verifying step by step that a sequence of logical steps is taking place: Events required
to validate a complete transaction.
In this case we are going to do something easier, possible in Pandora FMS Open Source version. We’re
going to connect to a website and verify that it returns a specific code. Now we’re going to connect to
the Pandora FMS module library website (http://pandorafms.com/Library/repository/en) and verify if the
text string “Main categories” is returned at the output (see image):

For that, we’ll create a network check, similar to the previous example. In this case, we’ll use the “Check
HTTP” generic template and we’ll modify some advanced fields, as you can see in the following screenshot:
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^M characters need to be written just as it is since they represent a carriage return. For HTTP protocol
it’s necessary to do 2 carriage returns after the petition. Final result must be a check that returns OK,
as this one:

4. Add an alert (email sending) when a problem occurs
In Pandora FMS, the most basic method of alerting is to assign an alert to a specific module. It’s possible
to do more advanced things (event alerts, correlation, etc), but they are not written in this guide. Our
first alert will consist of simply sending an email when a monitored machine (with the Host alive module)
is down.
Alerts in Pandora FMS are composed of three elements: Command, Action and Template. In our test
case we are going to use a predefined command (email sending). We’re going to modify an action that
already exists (Mail to XXX) and we’ll use an template existing too, the Critical condition template, that
will execute the alert when the module in question appears in critical status.

4.1 Server configuration
To correctly perform the email command, we must set up in the pandora_server.conf file a mail server
that allows to do relay. In our example, the mail server placed at 192.168.50.2 has this function enabled.
We must introduce the IP address of your local mail server or one on the Internet (configuring the
Authentication for it). To modify the configuration file of the server, we must access to it through a shell
or terminal that we can open from:
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Once the shell is open, we need to open the configuration file placed at /etc/pandora/pandora_server.
conf as root user, so we should switch to root with sudo su before doing it:

We look for the lines we can see in the screenshot above and we configure them as in the screen. In
this case, we have to consider that the mail server is placed at 192.168.50.2. If we don’t have a mail
server, we can use a gmail account, for example. We can see a quick guide about how to configure the
Pandora FMS server to make it work with a gmail account in this link: http://wiki.pandorafms.com/index.
php?title=Pandora:Configuration_emails_alerts
Lines beginning with the # character are comments and they are not taken into account by the server.
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Once the changes are finished we press Ctrl+X to exit and we confirm to save the changes:

After we save changes then we need to restart pandora_server:

service pandora_server restart

4.2 Alert configuration
As we commented previously, Pandora FMS alerts are composed of three parts: Command, Action and
Template. We find these options in the Manage Alerts section.

To configure this alert we only need to modify the action. The action we will use is Mail to XXX. In this
case, if we need to change the email address we want to use (info@artica.es), we could modify “Mail to
XXX” to “Mail to info@artica.es” so that we can identify which action we are executing.
We will modify the appropriate field and insert the correct destination email address.
In field 2, we leave the text that is shown in the screenshot. Here are using 2 macros that will replace
during execution the agent name and the module that has generated the alert.
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We select the Mail to XXX action and we edit the email address (info@artica.es).
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4.3 Assign an alert to a module
We navigate to the edition of the agent where we have the defined module and we click on the alert tab:

Now we add the module (Host Alive), the template (Critical Condition) and the action (Mail to XXX). We
add the alert.

Once added, we can observe the alert in the Agent View to determine whether is running or not, watching
the color of its status:
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We can wait (or force) until the host is down to see if the alert works, or we can “force the alert” to see
if it actually reaches the mail. We’ll click on the Force icon (see image):

Finally, the mail with the alert should appear in our inbox. As a “forced” alert it puts N/A in the field data.
In a real case it will put the real values of the module into the message.

Pandora FMS alerts are extremely flexible. In some occasions they appear difficult to use. There is a
specific chapter in the official documentation for alert management: Alerts in Pandora FMS

5. Monitor a Windows Server with a software agent
Pandora FMS provides 2 types of monitoring: remote (from the Pandora FMS server to different devices)
and local (installed as a software agent on each machine to monitor, in charge of extracting the information we wish to observe and forwarding it to the Pandora Server).
At this point, we are going to explain the installation of a software agent for a Windows computer and
the basic monitoring of it:
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5.1 Agent Installation
First of all we need to download the Windows agent. We can get it from:
http://sourceforge.net/projects/pandora/files/Pandora%20FMS%205.1/SP2Final/Windows/
In this link we can choose between the 32 and 64 bits agent.
Once the agent is downloaded we execute it by clicking twice over it, and it will show a language
selection screen:

This is a standard Windows installer that will ask you to follow the steps. Once we accept the license we
can move through the different screens of the installer. We select the root where we want the Pandora
FMS agent to be installed (by default it’s installed at C:/Program Files/pandora_agent). We can change
the destination by pressing Browse and entering the new location. When done, we press Next:
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We wait while the files to be copied. We configure the IP address (or name) of the Pandora FMS server,
that will receive the agent data and the group we want to associate the agent to.

In the following screen we can see the option to enable the remote configuration. It’s important to have
it activated through a 1 if we want to have a copy of the agent of the Pandora FMS server, and from there
can add, edit and delete local modules directly from the agent.
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We decide if we want to start the the agent service at the end of the Pandora FMS agent installation.
Otherwise we’ll have to do it manually, or it will start when Windows is restarted.

Once this process is finished, the Windows agent is installed and running on the target computer.

5.2 Checking the information returned by the agent
After installation, once the Windows agent is launched, it’s time to check what this agent is reporting.
For that, we should know the name that the agent is going to use to report. By default the agent is
created with the host name. We should see the name of the Windows host by executing the hostname
command via cmd.exe.
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Now that we know the name of the agent, the next step is check if the agent has been created in Pandora FMS. For that we have several options. The first one is search in the Agent Details, in the group where
the agent has been created, in our example the “Servers” group.

The faster and more efficient way to find the agent is by searching directly through the Pandora FMS
search bar indicating the name of the agent.

Here we’ll find the agent and by clicking on it we get into the information that it’s reporting.

By default the Windows agent comes with several local modules pre-configured and in charge of basic
monitoring, such us CPU load, % of free RAM (FreeMemory), free space in MB in the disks, DHCP status
(DHCP Enabled) and number of processes (Number processes).
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If you need to add new modules to this agent you can check the advanced documentation here: Monitoring with software agents.
We can see graphs generated with the historical data of the module and a chart with the history of the
ones from this view clicking on the icons highlighted in the following screen:

6. Create a Visual Screen with details of my monitoring
One of the options that Pandora FMS provides is the ability to create Visual Consoles. The Visual Console
allows the user to represent the information about the monitoring, in real time, customized by the user in
a totally graphic way. In this example of the Visual Console we are going to create a network distributed
all over the world, and if we click on the node that appears in Spain we can see other elements of the
installation of the Spain network.
The power of the maps allows us to summarize the status of a son map in the visualization of the
father map, i.e if one of the elements displayed on the map of Spain is on critical status, the icon that
represents Spain will change color to red. This allows us to set customized hierarchies at the time the
information appears. Maps can contain information about the status of groups, agents, modules,etc.
They can also include graphs and data (numerical or text), and text tags and icons.

6.1 Creating Map 1 (Father)
In this first map we are going to add the status of several agents distributed on a world map. We can
do it manually, one by one, or through the Wizard. To make this task easier and for our example we will
use the Wizard:
The first thing we have to do is create a new map we will call World Map.
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Once created we click on the elements Wizard:

In the Wizard we select the kind of element, in this example Static Graph, the image we want to use, if
we want to use an item per agent or module (in our case per agent), and we select in the list the agents
we are going to add.
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We click on Add button and it will show all the elements created on the map, as we can see in the next
screenshot

We move all the elements as we wish them placed on the map, clicking and dragging to their new location.

6.2 Creating Map 2 (Son Map)
In the second map we will find an element that indicates the status of the main agents. We will see also
a graph of the FreeRAM module of the same agent.
The first thing is to create the new map as we did in the previous case:
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Once created we add the element that shows us the agent status in Static Graph section, as it appears
in the following screen:

We also create the graph with the configuration attached, by clicking on the graphs icon, adding the
agent and the module about which we want to see the graphic.
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We have created the main element of the map, so now we are going to create a new element for each of
the modules existing in the agent. For that we will use the Wizard, doing the configuration as shown in
this screenshot. We select Static Graph, of the agent and of the modules indicated. We put the name
of the module as a tag and configure the parent to an Item created in the Visual Map. In this case the
previous element that we added.
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After creating all those elements they will appear attached to the mail element, and we can move them
by dragging them with the mouse to the position we want them to appear.

6.3 Link both maps
We created the 2 maps in the previous steps. In this step we are going to ensure that when we press in
the element placed over Spain in the “World Map” this causes the “Spain Map” to open.
For that we open the “World Map”, in editing mode, by doble-clicking on the 192.168.70.70 element. It
will show the element editor. We click on advanced options and on the Map Linked option. We select the
Spain Map. Then we update the element.
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When we return to the World Map view, we click on a element placed over Spain and it will directly open
the map of Spain. If in the map of Spain would be only an element in red, the icon that represents Spain
in the father map will appear in red.
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7. Adjust my monitoring (threshold, units, others)
In this chapter we’ll see how to configure some of the advanced options of a module.
We navigate to the Agent Modules View.

We select the module to configure:

After that we open the “Avanced Options” tab and we configure the fields to reflect the information we
wish to appear.
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In the next chapters we’ll see how to configure “Unit” and “Interval” fields, and the thresholds “Warning
Status” and “Critical Status”.

7.1 Configuration of the module units
This option allows the user to define the units of the data obtained from a module. This unit will be included in graphs and reports, so that is easier to manage and understand the data shown to the user.
In the example, we want the IOWaitCPU module to have “ticks/sec” as our measurement unit. We place
into the field “Unit” and write our choice.

Finally we click on the “Update” button and we check if our unit is properly shown in the Modules View.
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7.2 Configuring the interval of a module
Configuring/modifying the module interval will define how often we want this module to be executed.
This is applied to remote modules (not local), because the local modules are configured in a more complex way. The more frequently we monitor a remote system, the higher the load we place on the monitored system and the monitoring infrastructure.

We click on the “Update” button and we’ll have the module configured.

7.3 Configuration of the module threshold
In this section, we’ll configure the “Warning” and “Critical” threshold for a module, which defines what
values a module must reach to be in Critical, Warning or Normal status. The easiest way to understand
this concept is through an example:
In our case we have a module of the CPU that we want to add thresholds for. Undefined, this module will
always be in “Normal” status (green) when the value is between 0% and 100%. If we want to see this
module in “Critical” or “Warning” status when the CPU reaches a predetermined %, we must configure it
by setting the thresholds of “Warning Status” and “Critical Status”, as desired. In our example we’ll configure it to turn the module into “Warning Status” when the CPU reaches the 60% of the module usage,
and into “Critical Status” when it exceeds 80%.

After setting the thresholds, we only have to press the “Update” button and we’ll have our thresholds
properly configured. The next received data will compare against those thresholds.
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7.3.1 Advanced Parameters of the Thresholds
The “inverse interval” box is used to defined non contiguous ranks. In this example, the module will turn
into the Critical status if the value is under 20 and/or over 80.

In text string type modules, the threshold is defined as a substring. Likewise, it’s possible to invert it to
make the module turn into Critical if it doesn’t have the substring as a parameter:

7.3.2 Other Advanced Parameters
The configuration of a module is very flexible, with dozens of possibilities. Explore the Pandora FMS official documentation to learn more about all of the options.

8. Problem solving. Where to look, who to ask
8.1 Configuration files and sources of diagnosis information
The main configuration files that you could need to review are the following:
/etc/pandora/pandora_server.conf. Main configuration file of the Pandora FMS server. If we touch
anything here we’ll need to restart the Pandora FMS agent.
/etc/pandora/pandora_agent.conf. Main configuration file of the Pandora FMS software agent in Unix.
If we touch anything here we’ll need to restart the Pandora FMS agent.
%PROGRAM_FILES%\pandora_agent\pandora_agent.conf. Main configuration file of the Pandora
FMS software agent in Windows. If we touch anything here we’ll need to restart the Pandora FMS service
agent.
/etc/my.cnf. Main configuration file of MySQL.
/var/www/html/pandora_console/include/config.php, Main configuration file of the Pandora FMS
console. During the installation it is autoconfigured, but if we need to change any environment parameters (path, IP, user/password of MySQL, host of MySQL) we have to modify it manually.
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Sources of information (logs) where we can find more information, errors, etc:
/var/log/pandora/pandora_server.log. Log file of the server, it contains very important clues. If we
want more details we have to modify the “verbosity” parameter of the configuration file of the server to
show more details.
/var/log/pandora/pandora_server.error. Log file of errors not captured by the server, usually nasty
things.
/var/log/pandora/pandora_agent.log. Log file of Unix agent.
%PROGRAM_FILES%\pandora_agent\pandora_agent.log. Log file of Windows agent.
/var/www/html/pandora_console/pandora_console.log, Log file of the Pandora FMS console.
/var/log/httpd/error_log, Log file of errors of the Apache server (httpd)
/var/log/messages, Log file of the system
dmesg, Command that shows Kernel warnings.
/var/log/pandora/pandora_snmptrap.log, Traps SNMP logs. If there is any error in the SNMP traps
console boot it can show error traces here.
/var/log/mysqld.log, Mysqld log.

Also helpful to know something about the permissions of some directories:
/var/spool/pandora/data_in/ Should be pandora:apache with permissions 755.
/var/log/pandora/ Should be pandora:root with permissions 755.
/var/www/html/pandora_console/include/config.php Should be apache:apache with permissions
600.

8.2 Support
Pandora FMS Forums: Our community forum is open to everybody, create an account and ask freely!
Pandora FMS FAQ: You have also a FAQ (Frequently Answered Questions) that can help you to find a
tip or solve a problem.
Pandora FMS Official Training: And of course, you can have official training. There are several levels
of certification on Pandora FMS.
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